Upgrading to CitectSCADA 2015

By Samantha Serna
July 2015

Executive Summary
The aim of this white paper is to centralize all sources of information in relation to the upgrade process and pathways to CitectSCADA 2015, from versions as early as CitectSCADA 5.21.

Two main methods are described:
- Offline upgrade
- Online upgrade

Pre-requisites and post upgrade considerations will also be discussed.
Introduction

The purpose of this document is to outline best practices for upgrading to CitectSCADA 2015 (7.50). It is also intended to provide you with links to various documentation and resources, to assist you in the upgrade process.

In the first section of this white paper we will highlight the advantages of upgrading to the latest version, including the new features available in CitectSCADA 2015.

Later, we will go into the system requirements and planning stage of the upgrade: what you will need to backup and keep from your current version, and what you will need for your new system to deliver optimum performance after the upgrade.

After that we will describe how to upgrade one SCADA server. This will help us build the foundation for an online upgrade: in this process you will need to upgrade a second server, allowing you to upgrade without any downtime.

There will be two cases described for an online upgrade:

1. Starting from CitectSCADA 7.20 SP4 / SP5A
2. Starting from CitectSCADA 7.40 SP1

There are minor differences that need to be taken into consideration when upgrading from these two starting points.

Finally, we will describe the steps you need to take to help ensure the upgrade has been successful, as well as other changes you will need to make after your project is running stable on CitectSCADA 2015.

Benefits of Upgrading

Benefits of Upgrading

Operating System (OS) and System Compatibility
CitectSCADA 2015 has been validated for Windows 8.1 and Windows Server 2012 R2. Please check our Compatibility Matrix for a comprehensive list of compatible OS.

Supportability and latest releases
Most updates and fixes have been developed for CitectSCADA 2015. Versions 7.20 and 7.30 will go into mature phase at EOY 2015 and 7.40 at EOY 2016. Neither Service packs nor fixes are developed for versions in the mature phase. For more information on this, please check CitectSCADA's Support Lifecycle.

Access to new features
Any new release of CitectSCADA will contain new and unique functionality and features that have been developed in order to satisfy market trends and our customer’s needs.

Why upgrade?

Why upgrade?

Operating System (OS) and System Compatibility
CitectSCADA 2015 has been validated for Windows 8.1 and Windows Server 2012 R2. Please check our Compatibility Matrix for a comprehensive list of compatible OS.

Supportability and latest releases
Most updates and fixes have been developed for CitectSCADA 2015. Versions 7.20 and 7.30 will go into mature phase at EOY 2015 and 7.40 at EOY 2016. Neither Service packs nor fixes are developed for versions in the mature phase. For more information on this, please check CitectSCADA’s Support Lifecycle.

Access to new features
Any new release of CitectSCADA will contain new and unique functionality and features that have been developed in order to satisfy market trends and our customer’s needs.

What’s new in CitectSCADA 2015

Depending on your starting version, there will be a lot of features that might be new to you. You can check all the details in the product documentation in the section Getting Started > What’s New in v7.x > Previous Releases. Also available online.
The following features are new and exclusive to CitectSCADA 2015:

**Backup and Restore Included Projects**
CitectSCADA 2015 now allows you to add a project's included projects to a backup file. This will allow you to have the option to select which of its included projects you would like next time you restore it into another CitectSCADA 2015 installation.

**Reading product version from a backup**
These changes coincide with some improvements to the Restore Project tool, including the addition of an Original product version field that indicates which version of CitectSCADA was used to create the selected backup file.

**Partial Associations can be used with Dynamic Associations**
In CitectSCADA 2015, Dynamic Associations (Super Genie Substitutions) can now use a full or partial; variable tag, equipment name, and or equipment.item references. Introducing partial association support means:

- Less or no code when using Dynamic Associations (see Using Equipment References with Dynamic Associations and Using Metadata - example 3 for more Information)
- Context of the dynamic association (Super Genie substitution) is maintained directly within the graphics page
- Easy to Maintain

**Run CitectSCADA 2015 as a Windows Service**
In the past, 3rd party tools were necessary to launch CitectSCADA 2015 as a Windows Service.
Now, you only need to configure the service named "Citect Runtime Manager" in Microsoft™ Management Console on each server computer, allowing for unattended operation of a system's servers.

**Extended Memory Mode**
In CitectSCADA 2015, you can configure an alarm server to operate in Extended Memory mode. This allows the alarm server process to utilize memory beyond a 4GB limit.

Extended Memory mode enables efficient query handling under the following circumstances:
- On systems with a large archive of historical alarm data
- On high-capacity systems that can generate a large number of alarms

**OPC Factory Server Version Update**
The installer for CitectSCADA 2015 now allows you to install version 3.50 of Schneider Electric's OPC Factory Server (OFS). This version includes all the latest security patches and is recommended for all customers using OFS. You can easily install OPC Factory Server v3.50 from the launch page of the CitectSCADA installer.

**What's new in CitectSCADA 7.40 SP1**

**Library_Equipment Include Project**
The Library_Equipment include project comprises of a series of genies and pop up page templates, including:
- Diagnostic and status information popup pages for Schneider Electric M580, M340, Premium and Quantum PAC range.
- Popup pages with adaptable links to FactoryCast Module statistics and summary pages for M580, M340, Premium and Quantum PAC range.
What’s new in CitectSCADA 7.40

**Software Licenses support on Virtual Machines**
Software licensing method was introduced in CitectSCADA 7.30, but was unsupported for virtual environments. In CitectSCADA 7.40, Software Licenses are supported on Virtual Environments.

**Referencing a variable tag using Equipment.Item**
In CitectSCADA 7.40 you can now reference a variable tag using associated equipment and item (with the equipment.item syntax). Known as object based referencing you can create true object libraries with matching graphics and database components.

**Equipment Editor Interface**
In CitectSCADA 7.40 you can add equipment types, create instances of equipment based on equipment types, and edit and delete equipment in the equipment hierarchy in your projects using the new equipment editor interface. With the equipment editor you no longer need to write XML. Changes made are saved directly to the XML template.

What’s new in CitectSCADA 7.30

**New OPC DA Server**
The new Citect OPC server is OPC Data Access solution (OPC DA) v2.05 and v3.00 compliant, and provides specifications for client and server applications that are focused on the continuous communication of real-time data. This allows the SCADA system to provide real-time data to any compliant OPC DA clients, including applications such as Ampla, OSisoft PI and Vijeo Historian.

**Software Licensing Method**
Software Licenses work in the same way that USB dongle licenses do, without the need for a physical key. You will not need to wait for your USB to ship, you will receive an Activation ID once your payment has been processed and you can activate online immediately.

**Equipment Hierarchy**
The concept of "equipment" was introduced in 7.20 as a means of providing logical groupings of SCADA objects such as tags, alarms and trends. In the 7.30 release, it has been expanded to be hierarchical, and to be more closely integrated with the functioning of SCADA objects. Each item in the equipment database can be assigned a place in a hierarchy of equipment. The hierarchy is based on the equipment name, and each item of equipment is specifically identified to signify its level in the hierarchy.

**New SQL interfacing Libraries (for SQL Cicode functions)**
CitectSCADA 7.30 features a new interface between SCADA and your SQL database using ADO.NET. If your project uses legacy SQL Cicode commands, this is largely hidden functionality. The new Cicode commands have the same functionality, but are more robust.

**Scheduler**
The Scheduler is a calendar based programming tool that allows you to manipulate tag values within a project. It can be used to create a sequence of automatically executed commands, delivering a valuable scheduling tool for applications.

Preparing your Upgrade

In this section of the document we will go into the details of the preparation steps required before you start the upgrade process.

First we will introduce terminology and differentiate the different types of upgrade. Then, we will describe briefly the suggested upgrade path for different versions of CitectSCADA.

---

1 VirtualBox not supported
Finally, we will enumerate the system requirements and files you need to get from your current system before you proceed to upgrade.

Planning for your upgrade

Before you start thinking about upgrading there is one important question you need to answer:

Can my system tolerate downtime and loss of data?

If the answer is yes, then an offline upgrade will be suitable for you.

If the answer is no, then you require an online upgrade.

The main difference between them is the resources and system requirements necessary to achieve it.

To be able to conduct an online upgrade, you must have at the very least a pair of redundant servers.

In the sections below, you will learn in detail about the two processes. Regardless of your desired option, you will need to learn how to do a offline upgrade, since this is required to execute an online upgrade.

Upgrade Path

Historically, some versions of Citect have included substantial changes to the product, which required incremental upgrades involving many intermediate steps between very distant versions (i.e. 5.21 to 7.20).

We have improved the upgrade code so that fewer steps are necessary to go from 5.21 to CitectSCADA 2015, and the number of necessary steps will once again depend on your answer to the question: Can my system tolerate loss of data?

If the answer is yes, then you can upgrade your project from as early a version as 5.21, directly into CitectSCADA 2015 (v7.50).

If the answer is no, then you need to follow an online upgrade process and you need to also follow an upgrade path that will depend on your starting version:

If your starting version is previous to v7.20 SP4
You need to restore your project into v7.20 SP4 or SP5A compile and run the project in order to restore and convert your historic alarm data.

If your starting version is v7.30, v7.30SP1
You need to restore your project into v7.40 SP1 and compile and run the project in order to restore and convert your historic alarm data.

If your starting version is v7.40
Install SP1 and compile and run the project in order to restore and convert your historic alarm data.

For versions prior to 5.21 you are strongly encouraged to follow the procedures described in KB article Q4698.
Hardware Requirements

The following table indicates the recommended computer hardware specifications for CitectSCADA 2015 “All Core Components” installation and all optional components.

Table 1

<table>
<thead>
<tr>
<th>Description</th>
<th>Recommended Specification of Higher</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Intel Pentium</td>
</tr>
<tr>
<td>Processor Speed</td>
<td>4 cores @ 2.0 GHz for Servers or 2 cores @ 3.0 GHz for Clients</td>
</tr>
<tr>
<td>Random Access Memory (RAM)</td>
<td>8GB for Servers or 4GB for Clients</td>
</tr>
<tr>
<td>Network Speed</td>
<td>1GB</td>
</tr>
<tr>
<td>Available Disk Space</td>
<td>100GB</td>
</tr>
<tr>
<td>Graphics Adapter</td>
<td>1024 x 768 pixel resolution, with 128MB of VRAM</td>
</tr>
</tbody>
</table>

Due to limitations in the Computer Setup Editor, Project Editor and several input forms in CitectSCADA, it is a requirement that screen resolution be set at 1024 by 768 pixels or higher.

Depending on your project configuration, size and performance requirements you will need to adjust your hardware resources accordingly.

Given the increasing complexity of systems, and requirements from our product, it is safe to assume that a project running using CitectSCADA 2015 will take more hardware resources than its 6.10 counterpart to deliver the same responsiveness, so please bear in mind this fact when/if purchasing new hardware.

Please refer to Appendix 1 for an example of the performance of a project running with CitectSCADA 2015, and standard hardware and software configuration.
Software Requirements
The following table indicates the system software that is needed on any computer onto which you want to install the CitectSCADA 2015 “All Core Components” installation and all optional components.

<table>
<thead>
<tr>
<th>CitectSCADA Component</th>
<th>Minimum System Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Core Components</td>
<td>Operating System&lt;br&gt;Windows 8.1 (32 and 64 Bit) or&lt;br&gt;Windows Server 2012 R2 or&lt;br&gt;Windows 7 with SP1(32 and 64 Bit) or&lt;br&gt;Windows Server 2008 R2 with SP1 and Microsoft .NET Framework 4.0 (installed with CitectSCADA if not already installed).&lt;br&gt;Microsoft .NET Framework 2.0 (x64) is required by “Schneider Electric License Manager” and “Schneider Electric Software Update” if using Windows Server 2012.&lt;br&gt;Internet Explorer Version 8.0 or greater (32 bit only).&lt;br&gt;A Local Area Network (LAN) if you want to have multiple clients access a remote server.</td>
</tr>
<tr>
<td>Schneider Electric License Manager</td>
<td>As for All Core Components</td>
</tr>
<tr>
<td>CitectSCADA Web Server</td>
<td>As for CitectSCADA all Core Components with the addition of:&lt;br&gt;A LAN running TCP/IP and Microsoft Internet Information Services (IIS) See Microsoft IIS on the next table</td>
</tr>
<tr>
<td>CitectSCADA Web Client</td>
<td>Internet Explorer versions 8 or greater (32 bit only).</td>
</tr>
<tr>
<td>Product Documentation</td>
<td>As for All Core Components</td>
</tr>
<tr>
<td>Project DBF Add-in for Excel</td>
<td>As for All Core Components, and Microsoft Excel 2007 or later. Microsoft Excel 2013 (32 bit only)</td>
</tr>
</tbody>
</table>
Microsoft IIS Compatibility
For correct operation of the WebServer, install the appropriate Microsoft Internet Information Services (IIS) feature for your operating system:

### Table 3
**IIS requirements for CitectSCADA 2015's Web Server**

<table>
<thead>
<tr>
<th>OS</th>
<th>IIS Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012 R2</td>
<td>8.5</td>
</tr>
<tr>
<td>Windows 8.1</td>
<td>8.5</td>
</tr>
<tr>
<td>Windows Server 2012</td>
<td>8.0</td>
</tr>
<tr>
<td>Windows 7</td>
<td>8.0</td>
</tr>
<tr>
<td>Windows Server 2008 R2 SP1</td>
<td>7.5 (You need to enable on Windows features)</td>
</tr>
</tbody>
</table>

- Please install IIS with the default settings.
- Also, please make sure to enable the following components:

### Table 4
**IIS configuration for CitectSCADA's 2015 Web Server**

<table>
<thead>
<tr>
<th>IIS Component</th>
<th>Features to Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Tools</td>
<td>IIS Management Console</td>
</tr>
<tr>
<td></td>
<td>IIS6 Management Compatibility</td>
</tr>
<tr>
<td></td>
<td>-IIS6 Metabase and IIS6 Configuration compatibility</td>
</tr>
<tr>
<td></td>
<td>IIS Management Services</td>
</tr>
<tr>
<td>Application Development</td>
<td>ASP</td>
</tr>
<tr>
<td></td>
<td>ISAPI Extensions</td>
</tr>
<tr>
<td>Security</td>
<td>Request filtering</td>
</tr>
<tr>
<td></td>
<td>Windows Authentication</td>
</tr>
</tbody>
</table>

File Inventory

In order to ensure a smooth upgrade and minimal disruption during this process there are a number of files, apart from your project backup, that you will need to take from your current system.

Again, the amount of files you need to collect will depend on whether or not your system can tolerate loss of data, but still, there are a number of files you need to collect regardless of your system conditions.

These files will depend heavily on your project configuration, and we recommend, when possible, contacting the developer of your project, since they will have the global picture of your project’s dependencies.

In the table on the next page you will find a list of the files you need to backup from your current system, or where to look for these files based on your project settings.
### Table 5
File inventory: All the files you need to backup before upgrade

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project backup (.ctz file)</td>
<td>This is the main file to capture. You can do this from Citect Explorer:</td>
</tr>
<tr>
<td></td>
<td>Citect Explorer  Tools  Backup</td>
</tr>
<tr>
<td></td>
<td>Please make sure you back up your project and all included projects.</td>
</tr>
<tr>
<td>Citect.ini</td>
<td>This file is found in the config folder</td>
</tr>
<tr>
<td>Data directory</td>
<td>This file is found on the path [CtEdit]Data</td>
</tr>
<tr>
<td>ALMSAV.DAT and ALMINDEXSAVE.DAT (For 7.20 and previous versions)</td>
<td>These files contain alarm configuration data as well as runtime data. Their path is defined on Citect.INI, or you can check Citect Explorer  Tools  Computer Setup Editor  [Alarm]SavePrimary</td>
</tr>
<tr>
<td></td>
<td>Default path: Same as Data directory</td>
</tr>
<tr>
<td>OR</td>
<td>The alarm database will be found on your Data directory, using the following naming convention: [Data]\MyProjectName\ClusterName.AlarmServerName</td>
</tr>
<tr>
<td>Alarm Database (For 7.30 and 7.40)</td>
<td>There will be as many databases as Alarm Servers you have on your project, please make sure you back up all of them.</td>
</tr>
<tr>
<td>Trend files: .HST and .00X</td>
<td>The path and names of these files are defined on the trend tag itself i.e.:</td>
</tr>
</tbody>
</table>

There is a known performance limitation of the file operating system when more than 3000 files reside in the directory. Also, care must be taken if changing filename structure, as Trend server doesn’t support these types of changes. Please read [KB article Q3823](#) for more information.

In this case, the files will be created on the data directory defined in \[CtEdit\]Data. The files will be named CPU.HST, CPU.001 and CPU.002 (after the trend name and number of files). If the filename is left blank it will put all files in default DATA directory, with the trend tag name as filename. **Default directory:** Same as Data directory.
## File Description

### Report files
These files contain the code that is executed on your Citect reports. They will always under `[CtEdit]User\MyProjectName`, and should be copied when you backup the project.

These files names are defined on the reports form: Project Editor→System→Reports

![Report files example](example.png)

### Custom ActiveX controls (.OCX)
Citect includes a number of ActiveX controls and most of these will be available with the CitectSCADA 2015 installation, but you need to backup your custom ActiveX controls. The developer of your project will know where these can be found.

Alternatively, you can check the contents of the ActiveX.dbf file on your `[CtEdit]User\MyProjectName` directory. On this file you will find an inventory of all the ActiveX controls used in your project, and their GUID.

Using the GUID, you can find the path to the ActiveX, as defined in the windows registry key: `KEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\"GUID"\In ProcServer32`

The default value for this key is a path to the .DLL or .OCX you need to backup.

### Device logs
These files will contain any logging you have configured in your project i.e. alarm logs, reports logs.

You will find their locations on the devices form: Project Editor→System→Devices

![Device logs example](example.png)

---

*When backing up files it is always useful to know the location for the CitectSCADA Data, User, Logs and Config folders.*

The current path for these can be found using the computer setup editor, or by looking at your Citect.INI file.

To access the computer setup editor you can go to Citect Explorer → Tools → Computer Setup Editor → [CtEdit] (On the left hand side, expand CtEdit menu to check)

Under this section you will find the Data, Logs, Config and User parameters, which contain the path under which to find these files.

In older versions, the Computer Setup Editor didn’t exist, but you can still access the .INI file through the menu Citect Explorer → View → Citect.INI

It is also good to know the default installation paths for these directories:

**Default path for Windows 7, Windows Server 2003-2012:**
`C:\ProgramData\Schneider Electric\CitectSCADA 7.XX`

**Default path for windows XP:**
`C:\Documents and Settings\All Users\Citect\CitectSCADA 6.XX`

Alternatively, you can type `%ALLUSERSPROFILE%` on the address bar of a Windows Explorer window and from there, navigate to the Schneider Electric or Citect directory, then to your desired Vijeo/Citect version.
Once you have figured out which kind of upgrade you need, outlined the upgrade path, checked your hardware and software requirements and backed up all necessary files, it is time to proceed with the upgrade process.

Earlier in this document we asked you to answer a simple question: Can your system tolerate any downtime and loss of data?

Based on your answer you will need an offline or online upgrade, as well as a determined upgrade path.

Now that you have done all that, we will introduce the concept of an Offline upgrade. This is the basic upgrade process and it will be required whether or not you are going through an online upgrade.

Please review carefully the steps to take in order to produce a successful offline upgrade. We will be using a starting version of 6.10 in this example.

### Backup your current project and relevant files

In this particular case, you need to be aware that 6.10 is not supported on Windows 7, and CitectSCADA 2015 is not supported on Windows XP, hence, this particular case would involve a change in Operating System, as well as on the default directory and paths definition.

To perform a backup of your project go to Citect Explorer and select your project from the list, and then go to Tools ➔ Backup... Please ensure you select Save sub-directories and Save configuration files is selected on the Backup dialog.

---

### Offline upgrade process

Please keep in mind the changes you make to file locations when backing up and restoring custom files, as you will need to change the paths reference in the project to reflect the new file locations.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
</table>
| Additional Files | Check your citect.ini or use your computer setup editor, on the Paths Section as it could contain runtime files used by custom code in the project.  
Also, check your system parameters, and any parameter defined under the Paths section.  
You will find their locations on the Parameters form, and look for Path: Project Editor ➔ System ➔ Parameters |
| Driver Hotfixes | If you are aware of any driver hotfix in your system, please backup this driver dll, which you’ll find on the BIN directory, with all SCADA program files.  
Also be aware that the fixes contained in this hotfix may have already been included in the drivers which ship with CitectSCADA 7.50.  
Additionally, you can check our Driver Web for the latest releases. |

In this example this path points to the Data directory, which you should have backed up already, but it might not be the case, so please double check.
Uplgrading to CitectSCADA 2015

For a list of the files you need to backup, please see Table 5.

Upgrade your licenses

In order to do this, your site will need to have a valid support agreement or you need to purchase a license upgrade. You can upgrade your key or soft license using our online license generator. You can also check the support status of the key or soft license at the same URL.

- If your license is out of support, please get in touch with your Schneider Electric account manager/sales rep who will help you with pricing and guide you through the purchase process.
- If your license appears as out of support, but you are not sure who your account manager is, please send an email to scada.orders@schneider-electric.com with your license and Site ID details or your purchase order information to sort out your support status.

Plan your upgrade path

If you need to preserve historical data, then you should follow the upgrade path described in this section. For this you will need to backup files and projects at every milestone of the upgrade path. Also, you will need to be able to install and run all versions of Citect indicated on the upgrade path.

Uninstall your current SCADA version and install the next version defined on your upgrade path

In this particular case, you most likely need new hardware or a new OS, so this step would be unnecessary. In the case in which you don’t need to format your machine or a new machine in itself, we recommend uninstalling the older version and installing the newer one once you have completely uninstalled the previous one.

Restore your project

The following steps you will need to repeat as many times as milestones you have on your upgrade path (It should not be more than two milestones if upgrading from v5.21 or greater).

Please check the workflow in Figure 3 below for a better idea of the process:
Upgrading your project

As a default, when you restore a project from a previous version into a newer version, CitectSCADA’s design environment will force an update, and you will get the following warning:

If this doesn’t happen, you can force an update of all projects by setting the [CiEdit]Upgrade.INI parameter to 1 and restarting CitectSCADA Explorer. Once you restart it, you will get the following message:

In this example (because the initial version was 6.10 and it’s only supported on Windows XP or earlier) you would need to restore the project in a new machine with Windows 7 or newer and CitectSCADA v7.20 SP4. After completing the first iteration of the workflow, you would need to uninstall v7.20 and install CitectSCADA 2015.
After clicking Yes all projects will be upgraded:

After the automatic upgrade process is complete, please complete the process by following these steps:

1. Pack each include project: Project Editor → File → Pack.
2. Library Pack on each include project: Graphics Builder → Tools → Pack Libraries.

Migrate your project

The automatic update that occurs when you restore your older project into the newer CitectSCADA version does not fully upgrade your projects, and needs to be followed by the Migration Tool (if migrating from v6.x this is particularly noteworthy).

The automatic upgrade is a passive action which updates the database field definition for any database that has been changed between the two versions and copies new files that are necessary in the current version.

The Migration Tool is a separate application which has to be manually run after the automatic upgrade has been executed. It can be initiated after you have prepared the project for final migration. This tool will accommodate the changes in project functionality that are incorporated in 7.0 through to the current version.

To use the Migration tool, select your project on Citect Explorer and go to Tools → Migration Tool. You will be presented with the following dialog:
Please find in the next table a description of what every option does.

Table 6
Options for CitectSCADA 2015’s Migration Tool
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Remove obsolete Memory and Alarm devices    | Select this check box if you wish to delete these types of devices after successful migration  
**Note:** Do not select this check box when you run the tool for the first time on a project that contains any included projects which are shared with more than one master project. If you want to delete obsolete devices under these circumstances, you can run the tool a second time using this option if the migration is successful after it is run the first time. |
| Append to existing log file                 | Use this option to append information about the migration process to the existing Migration Tool log file (located in CitectSCADA’s User directory). If this option is not selected, a new log file will be created when migration is complete.                                                                                                                                           |
| Create roles from User security information | Select this option if you wish to migrate the users’ database from an existing project.                                                                                                                                                                                                                                                   |
| Copy XP_Style menu into Tab_Style menu      | Select this option to convert legacy menu entries to the format necessary for the new menu configuration system. By default, this option is unchecked to avoid potential compile errors that may occur if the legacy menu.dbf contains functions which have been removed.                                                                                                           |
| Migrate included projects                   | Select this option to migrate the included projects associated with the selected project.                                                                                                                                                                                                                                                   |
| Migrate equipment database                  | Select this option if you have an existing equipment database that you want to migrate into this version. When upgrading from an earlier version, and the “PARENT” field of the equipment table was used, you should select this check box. Otherwise existing data from the PARENT field will be ignored. If runtime browsing is used, the PARENT field will return the equipment parent (the substring of the equipment name without the last ‘.’ and anything after that). To retrieve information that was stored in the previous "PARENT" field the "COMPOSITE" field should be used. |

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Migrate ABCLX to OPCLX</td>
<td>Select this option if you want to migrate devices that currently use the ABCLX driver to the OPCLX driver. Select the Configure button to indicate which I/O devices you would like to migrate. Note: You should confirm that the OPCLX driver is installed before you use this option.</td>
</tr>
<tr>
<td>Migrate Trend/SPC storage method</td>
<td>If you select this option, the storage method will be set to scaled (2-byte samples) for all trends that have no storage method defined. Use this option to stop the compiler error message “The Storage Method is not defined”. In previous versions, a blank storage method would default to scaled. However, this is no longer supported, resulting in a compilation error.</td>
</tr>
</tbody>
</table>
To find a list with all deprecated parameters in CitectSCADA 2015, please read the Getting Started > What's New in CitectSCADA > What's New in CitectSCADA 2015 > Citect.ini Parameters in CitectSCADA 2015 help topic. Also available online.

So far, you should have been using the default .INI file that comes with the default installation of the version you are upgrading to. We do not recommend replacing your old .INI file into the new version, since it is likely that many parameters have been deprecated or changed behaviour.

However, we do recommend paying special attention to the following parameters, as they will be necessary to compile your project correctly and to set your design environment to your preferences.

If the following parameters are defined in your old .INI file, please ensure they are merged into the new version’s .INI file:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[General] TagStartDigit=1</td>
<td>Without this parameter you will encounter the ‘Tag not defined’ compiler error. Setting this to one, allows to define tag names that begin with numbers or symbols.</td>
</tr>
<tr>
<td>[General] CheckAddressBoundary=0</td>
<td>Without this parameter you could encounter the ‘Bad Raw Data’ or other tag address related errors. Setting this to zero, allows defining variable tags of the same data type in odd or even addresses. When this parameter is set to 1, all variable tags from the same data type must be defined on odd OR even addresses.</td>
</tr>
<tr>
<td>[CtDraw.RSC] ListSystemPages=1</td>
<td>This allows you to open popup pages from the Graphics builder.</td>
</tr>
<tr>
<td>[CtDraw.RSC] AllowEditSuperGeniePage=1</td>
<td>This allows you to edit super genie pages from the Graphics Builder.</td>
</tr>
</tbody>
</table>

Also, please merge any driver parameters from your old .INI file as they will most likely be necessary to interface with your I/O network.

Compile your project

After upgrading and migrating your project, you need to ensure runtime functionality works as it used to. As usual, you need to successfully compile your project before going to runtime.

When upgrading from previous versions, it is not uncommon to encounter compiling errors, particularly if you are upgrading from a very mature version.

One of the most common sources of compiling errors when upgrading is Cicode functions. This is because the functions have changed, have been deprecated, or simply because the compiler has become stricter in order to help you better prevent runtime errors.

You can find a list of the modified Cicode functions in the product help: Getting Started > What's New in CitectSCADA > What's New in CitectSCADA 2015 > Cicode Functions in CitectSCADA 2015. Also available online.

After clearing all the compiling errors, you need to ensure that your project is compiled in its entirety. To do this, please make sure that Incremental Compile is turned off.

To do this, go to Project Editor ➔ Tools ➔ Options and un-tick Incremental Compile.
After that, please Pack, Update Pages and Pack Libraries on your included projects before compiling one last time.

### Run the Computer Setup Wizard

Before running a project for the first time, you need to run the Computer Setup Wizard. This wizard is used to configure the Runtime Manager and other settings that are relevant to the runtime process.

The computer setup wizard will automatically determine your computer role based on the network addresses you have defined in your project.

After finishing the computer setup wizard, you can proceed to restore your historic data and other files and run the project.

### Restore runtime files

After compiling your project, you’ll want to ensure that all the files necessary for runtime are placed in the correct directories. For this, you’ll need the files you collected in File Inventory and you need to place the files in the corresponding directories, as defined in your .INI file and project configuration. Please read the note in this section for more information.

### Restore historical data files

The last step before running your upgraded project is to restore the historic data files.

#### Alarms:

For versions prior to 7.30:

In this example, and whenever upgrading from a version earlier than 7.20 SP4, particular attention needs to be given to the ALMSAV.DAT and ALMINDEXSAVE.DAT files.

The reason why 7.20 SP4 is an intermediate step in the upgrade path for these versions, is precisely that 7.20 SP4 contains the code that will convert these files into a format that can be read by the new alarm server architecture, introduced in v7.30, and maintained in CitectSCADA 2015.

Follow these steps to convert the files:

1. Make sure that the [Alarm]SavePrimary parameter points to the directory in which you have placed your backed-up ALMSAV.DAT and ALMINDEXSAVE.DAT.
2. After you run and verify the project, take the new ALMSAV.DAT and ALMINDEXSAVE.DAT files, as you will need to repeat this process when you upgrade to CitectSCADA 2015 (for an offline upgrade).
For versions 7.30, 7.30 SP1 and 7.40:

Whenever upgrading from a version between 7.30 and 7.40 SP1 particular attention needs to be given to the Alarm Database on the Data directory of the project.

Follow these steps to convert the files:

1. Make sure to place your backed-up Alarm Database on the directory defined by the [CitEdit]Data parameter.
2. Before starting runtime, please confirm that the directory that [Alarm]SavePrimary does NOT contain ANY ALMSAV.DAT nor ALMINDEXSAVE.DAT files.
3. After you run and verify the project, take the new Alarm Database, as you will need to repeat this process when you upgrade to CitectSCADA 2015.

Trends:

Follow these steps to convert the files:

1. Create the same file hierarchy on the new system.
2. Place the files in the same folders.
3. If you want to change the folder location, or you cannot replicate the same file hierarchy, please use the trend renamer tool: [Link]

Run your project

By now, your project should be ready to run. Now, it is a matter of checking all previous functionality works as intended, now that you have successfully upgraded from version 6.10.

As a rule of thumb, you need to check any Cicode that you needed to modify to compile in the new version.

You also need to test communications to your I/O devices, Alarm triggering and Trend capture are working ok.

When testing your I/O communications, you could run into the following warning during runtime:

This is only a warning, and it can be suppressed by setting the following .INI Parameter:

```
[<DriverName>]
OverrideOSProtection=1
```

Install CitectSCADA 2015

After you have completed all the milestones in your upgrade path, you will be ready to install CitectSCADA 2015.
Once your environment is clean from previous versions, you can proceed to install CitectSCADA 2015. If you are not familiar with previous versions of CitectSCADA, we suggest following the process outlined in the installation guide available with the installation files. You can download the CitectSCADA 2015 Installation guide from our website.

This process should be exactly the same as when installing the other versions from your upgrade path, with an additional consideration to keep in mind when upgrading from the 7.30, 7.40 path: You need to ensure that Schneider Electric’s License Manager and Floating License Manager have been completely removed from your system. This is to ensure the newer releases of the License Manager tools are installed correctly, since they contain new configuration that is valuable for CitectSCADA 2015’s correct performance. If you fail to uninstall the older versions of the License Manager tools before installing the new ones, your system might keep the old configuration, and you would not reap the complete benefits of the newer releases of these tools. As expected, this is particularly relevant if you are going to use Software Licenses.

In this section we will list common issues you might encounter during your Offline Upgrade which will be related to Compiling Errors and any other pre-runtime matters:

I cannot upgrade my License Key

1. Please make sure you have correctly installed the latest versions of CiUSafe and Sentinel Driver.
2. Please make sure the Authorization code matches the Key you are trying to upgrade. If you still cannot upgrade your license, please check KB article Q3672 for more information on the error codes.

I get many compiler errors and warnings that are not related to deprecated functions

As CitectSCADA evolves, the compiler feature becomes stricter in order to ensure project quality and runtime success. The fact that you are getting compiling errors that were not appearing before is a symptom of stricter compilation, which will result in more predictable and stable runtime.

CitectSCADA 2015 includes a new feature that will help you understand compiling warnings and fatal errors easier. There is a new field included in the compiling record:

If you search for ‘W1007’ you will find more information for this specific error code. In this example:
Now that you have learned how to do an offline upgrade, you can proceed to complete the online upgrade.

An online upgrade takes advantage of CitectSCADA’s native Server redundancy to minimize or avoid loss of data or downtime on your production system, allowing for one server to take ownership while the other is being upgraded.

Also, it is important to note that an online upgrade is the only way to avoid loss of data. It is customary practice in the industry to perform an upgrade in parallel. This is the process in which the two SCADA systems (the old version and the newer one) are running side-by-side. The old version is decommissioned after the new version has been fully tested and validated.

Using an upgrade in parallel approach, it is not possible to convert the data for the time in which the new version is being brought online, even if restoring historic files from the older version that is online at the same time. There will always be a data gap from the time you take the historic files, to the time you start your parallel SCADA system. An online upgrade is the only way to avoid loss of data.

Similar to the offline upgrade, you will need to follow the upgrade path, and repeat the process as many times as milestones you have in your upgrade path (It should not be more than two milestones if upgrading from v5.21 or greater).

In this chapter we will list the pre-requisites for an online upgrade, and discuss two scenarios considering the starting version: from 7.20 SP4 or SP5A and from 7.40 SP1.

Pre-requisites
As discussed previously, the online upgrade will allow you to avoid downtime and loss of data.

It is important that you take into consideration the complexity and size of your project when planning for this upgrade.

As you saw in the previous chapter, an offline upgrade can be a complex process, and it is important this has been completed thoroughly in order to avoid downtime and loss of data in your production system.

Please read the list of pre-requisites below before you start the online upgrade:

1. **At least one pair of redundant servers**: this is to upgrade one server at the time, while the redundant server assumes primary operation, avoiding downtime and loss of data.

2. **Upgraded project**: make sure your project runs and works properly on CitectSCADA 2015 before deploying to production and starting the online upgrade. If your project is
complex or you are upgrading from a version earlier than 7.20 SP4, it is strongly recommended that you have a test environment, as the offline upgrade could be complex and could involve a long server downtime if done on your production system.

3. **Restore runtime files:** ensure you have restored the necessary files for runtime onto the appropriate directories to avoid any disturbances on the upgraded live system.

4. **Capture data files:** to allow historic data to be restored into the new version, you need to capture the data files at the right time. This is described in detail in the online upgrade steps outlined below.

5. **Configure your running system for Online upgrade:** to allow this process to be as smooth as possible, we recommend leveraging of your current redundant system and adding the following citect.ini parameters before the online upgrade:

   - **[LAN] EarliestLegacyVersion:** use 7200 for 7.20 upgrade and 7400 for 7.40 upgrade. This will allow your upgraded servers to accept connections from the older version.
   - **[Alarm]EnableStateLogging:** set this parameter to 1, as it will allow logging the alarm synchronization messages into the syslog. The importance of this will be addresses in upcoming sections.
   - **[Alarm.<ClusterName>.<AlarmServerName>]ArchiveAfter:** this parameter is specific for an upgrade to 7.50. If this parameter is not set on CitectSCADA 2015, the alarm server it will not start up. This is configured for each Alarm Server instance. When configuring this parameter you need to decide what time period of data is that you wish to maintain during upgrade. For example, if you set this parameter to 1 week, it means that during the upgrade process you will lose any summary data that is older than 1 week. If you don’t want to lose any data, you need to set this parameter to the earliest data in your summary (7.20) or SOE (7.30 and 7.40).
   - **[Debug] Kernel = 1** (optional): we recommend enabling this to allow you to monitor the kernel during the upgrade. Specific situations in which you can check the kernel will be highlighted in later sections.

---

**Online Upgrade steps: 7.20 to CitectSCADA 2015**

In this particular scenario, you will NOT need to restore the alarm data files (ALARMSAV.DAT and ALRMSAVEINDEX.DAT) under most circumstances.

To enhance your experience during the online upgrade process, CitectSCADA 2015 is equipped to read this information from the redundant 7.20 (SP4 or greater) server that is still not upgraded.

1. Add the following parameter on the .INI file to all your server nodes before you start the online upgrade.

   ```
   ```

   You will need to restart the servers after adding the parameter for the changes to take effect.

2. Shutdown SCADA runtime on the Primary server

3. Upgrade CitectSCADA on this server according to the offline upgrade procedure.

4. Restart the primary server, now upgraded.

5. Now, the CitectSCADA 2015 server will build the new alarm database, and will import the historic data from the Standby 7.20 server.
6. Please check the status of the alarm server synchronization using the Alarm Server Kernel, on the Main Window:
   • When the Alarm Servers synchronization starts you should see the following message:
     *Alarm: Peer update request sent.*
   • Then you should see a number of messages with Update packets (number is dependent on your Alarm historic events and configuration).
     *Alarm: Update packet XXXX received.*
   • Finally, the following messages will indicate that the synchronisation has been finalised successfully:
     *Alarm: Database objects state synchronization completed.*
     *Alarm: Database is initialized, preparing to Start the Alarm Engine.*
     *Alarm: Starting Alarm Engine*
     *Alarm: Server startup complete.*

7. If you find that your Alarm Server synchronization cannot finalize, please place the ALARMSAV.DAT and ALRMSAVEINDEX.DAT on the [Alarm]SavePrimary directory. Please note that this should be a last resort.

8. Upgrade your client nodes one by one.

9. Once you are confident that synchronization of alarms, trends etc., is complete, and that your 7.50 clients are working correctly, shutdown runtime on the Standby server.

10. Upgrade CitectSCADA on this server according to the offline upgrade procedure.

11. Restart the Standby server, now upgraded.

12. Once the Standby is running fine, check for hardware alarms on connection to Primary.

13. Check functionality of the system as a whole.

14. Finally, test redundancy by switching off the Primary server and assuring Standby takes over and Clients switch over.

---

**Special Considerations: 7.20 to CitectSCADA 2015**

**Custom Alarm Filtering**
The AlarmSetQuery CiCode function was deprecated in 7.30. This means that if you are using custom alarm filtering code, you will most likely need to convert it.

Please refer to the following help topic for more detailed help with this process *Using CitectSCADA > Alarms > Using Custom Alarm Filters > Converting Legacy AlarmSetQuery Functions. Also available online.*

**Alarm server synchronization during online upgrade**
As part of CitectSCADA 2015 development efforts, we have spent time ensuring and testing the online upgrade from 7.20. This process should go smoothly as long as you follow this guide. However, in the event that there is a disconnection or timeout during synchronization between the 7.50 and 7.20 alarm servers you only need to shutdown your 7.50 server, delete the alarm database and re-start it again and wait for the synchronization between servers to finish.

Also, you can increase the timeout using the [Alarm]StartTimeout.INI parameter. This will allow the 7.50 server to wait for connection from its 7.20 peer.

If you find that the synchronization between the two servers is failing repeatedly, then you can delete the alarm database, and place your ALARMSAV.DAT and ALARMSAVINDEX.DAT
on the [Alarm]SavePrimary directory and the 7.50 server will convert the data. However, we recommend always trying the peer synchronization first.

**Changes during the upgrade process**
Because of the differences between CitectSCADA 2015 and 7.20, any actions that happen during the online upgrade process are subject to the incompatibilities that are not reconcilable between versions. However, the scenarios are quite particular and should not have a great impact if any, on your SCADA system's ability to fulfil its purposes. You can refer to Appendix 2 below for a list of functionality exclusions during upgrade.

**Online Upgrade steps: 7.40 SP1 to CitectSCADA 2015**

1. Make sure you have added the following parameters on the .INI file to all your server nodes before you start the online upgrade.
   
   
   You will need to restart the servers after adding the parameter for the changes to take effect.

2. Shutdown SCADA runtime on the Primary server

3. Upgrade CitectSCADA on this server according to the offline upgrade procedure.

4. Place the backed-up Alarm database on the [CtEdit]Data directory. This will allow a quicker synchronization of alarm servers.

5. Restart the primary server, now upgraded.

6. Now, the CitectSCADA 2015 server will synchronize its alarm database with the running 7.40 SP1 server. You need to wait for the synchronization process to finish, and this will depend on the size of your alarm database. The synchronization information is available from the main kernel window of the Alarm Process as well as the syslog.

7. Upgrade your client nodes one by one.

8. Shutdown runtime on the Standby server.

9. When the newly upgraded 7.50 server assumes the primary server role it will migrate the entire alarm database to the new format, and you should now be able to see Alarm Summary data on all migrated Clients.

10. Upgrade CitectSCADA on this server according to the offline upgrade procedure.

11. Restart the Standby server, now upgraded.

12. Check functionality of the system as a whole.

13. Finally, test redundancy by switching off the Primary server and assuring Standby takes over and Clients switch over.

**Special Considerations: 7.40 SP1 to CitectSCADA 2015**

**Alarm Save files**
When doing an online upgrade from 7.40 SP1 to v7.50 please ensure that any pre 7.20 Alarm Save files are removed from the v7.50 project folders (e.g. `<project_cluster>_ALMSAVE.DAT` and `<project_cluster>_ALMINDEXSAVE.DAT`).

The issues you might encounter during your Online Upgrade will be related to runtime issues and redundancy connectivity. For pre-runtime issues such as Compiler Errors please refer to this section.

It is important that your redundant servers are in communication during the upgrade, otherwise, it is not really an Online upgrade and you will end up losing data.

**My redundant servers fail to communicate**
I cannot make my redundant servers communicate and I keep getting the hardware alarm "Redundant Server not found"
1. Please make sure you have set your [LAN]EarliestLegacyVersion parameter correctly.
   a. In the case you are upgrading 7.20 use [LAN]EarliestLegacyVersion=7200.
   b. In the case you are upgrading 7.40 use [LAN]EarliestLegacyVersion=7400.
2. Please make sure you have run the computer setup wizard and set both servers to Networked mode:
3. Also, make sure to set the same server password on both servers on the computer setup wizard:

![Computer Setup Wizard: Server Authentication section](image)

My system is performing slowly even though Hardware and software requirements are met
Please check your system’s power options: Control Panel → All Control Panel Items → Power Options.

![Windows' Power Options](image)
Remove Upgrade related parameters
After finalizing the upgrade process and confirming that runtime is fully functional, we recommend removing or updating the following .INI parameters accordingly. You will need to restart the servers after changing the parameters for the changes to take effect.

- [Alarm]SavePrimary: please remove.
- [Alarm]SaveStandby: please remove.
- [Debug]Kernel = 0: this is to enhance security and keep operators out of the kernel.

It is important to note that after removing the EarliestLegacyVersion parameter, the next time you change your user’s passwords, we recommend you change all the passwords on one server, and then roll out the updated project in the same order in which you conducted the online upgrade (Primary Server, Clients, and finally, Standby Server). Please read KB article Q7865 for more information.

Upgrade third party applications
Please ensure that any CtAPI client is upgraded to use the DLL’s included in CitectSCADA 2015. Keep in mind that you also need to be aware of the User password’s changes. Please read KB article Q7866 for more information.

About the author

Samantha Serna Verenzuela is a SCADA & MES Global Support Engineer with a background in software development, business analysis and technical support. She holds a Bachelor’s degree in Electronics Engineering and a Master’s Degree in Microelectronics and Microsystems from the University of New South Wales. She has been with Schneider Electric since 2013.
Appendix 1: Performance Benchmark for a project based on a model Water Treatment plant

The benchmark info below intends to characterize the expected behaviour of a CitectSCADA system, under a specific software and hardware combination and with a controlled number of variables. Please note that this project was developed by Schneider Electrical personnel to achieve optimum performance and resource efficiency. This is for indicative purposes only, and could be considered the best case scenario in terms of performance for the system and facilities described here:

System specifications

Hardware

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
</table>
| Processor Speed        | **Server:** 4 cores @ 3.4GHz  
                          **Client:** 1 core @ 2.5GHz          |
| Random Access Memory (RAM) | **Server:** 16GB  
                          **Client:** 2GB                       |
| Disk Space             | **Server:** 2TB  
                          **Client:** 2TB                        |

Software

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
</table>
| OS          | **Server:** Windows Server 2008 R2 SP1 (64-bit)  
                          **Client:** Windows 7 (64-bit) | |

Project Specifications

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Devices</td>
<td>16 quantum PLCs</td>
</tr>
<tr>
<td>Servers</td>
<td>Redundant pair of I/O, Alarm, Trend and Report</td>
</tr>
<tr>
<td>Variable Tags</td>
<td>220,000</td>
</tr>
<tr>
<td>Alarms</td>
<td>120,000</td>
</tr>
<tr>
<td>Alarm throughput</td>
<td>720,000 events per day</td>
</tr>
<tr>
<td>Trends</td>
<td>36,000</td>
</tr>
<tr>
<td>Trend throughput</td>
<td>200,000,000 samples per day</td>
</tr>
<tr>
<td>Clients</td>
<td>5</td>
</tr>
</tbody>
</table>

Results

Items per time

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge Alarms</td>
<td>Time taken to acknowledge an alarm</td>
<td>0.1s</td>
</tr>
<tr>
<td>Browse Alarms</td>
<td>Browse all alarm records in the DB</td>
<td>0.4s</td>
</tr>
<tr>
<td>Alarm Count</td>
<td>Display 500 alarm counts</td>
<td>1.0s</td>
</tr>
<tr>
<td>Alarm Display</td>
<td>Display active alarm page</td>
<td>0.2s</td>
</tr>
<tr>
<td>Summary Display</td>
<td>Display summary page</td>
<td>0.2s</td>
</tr>
<tr>
<td>SOE Display</td>
<td>Display sequence of events page</td>
<td>0.5s</td>
</tr>
<tr>
<td>Process Analyst</td>
<td>Display 8 pens with 1 day span</td>
<td>1.5s</td>
</tr>
</tbody>
</table>

Resource usage

<table>
<thead>
<tr>
<th>Component</th>
<th>CPU</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Server</td>
<td>47.8%</td>
<td>5757 MB</td>
</tr>
<tr>
<td>(Running in extended memory mode)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trend Server</td>
<td>3.1%</td>
<td>696 MB</td>
</tr>
<tr>
<td>Report Server</td>
<td>0.6%</td>
<td>250 MB</td>
</tr>
<tr>
<td>IO Server 1</td>
<td>1.7%</td>
<td>525 MB</td>
</tr>
<tr>
<td>IO Server 2</td>
<td>1.8%</td>
<td>530 MB</td>
</tr>
<tr>
<td>IO Server 3</td>
<td>1.6%</td>
<td>527 MB</td>
</tr>
<tr>
<td>IO Server 4</td>
<td>1.6%</td>
<td>526 MB</td>
</tr>
<tr>
<td>Client</td>
<td>1.8%</td>
<td>255 MB</td>
</tr>
</tbody>
</table>
Appendix 2: Alarm items to consider during an online upgrade from v7.20 to 7.50

Alarm events that occur during upgrade
Since CitectSCADA 7.20 does not store the full set of timestamps in the active state records, it is impossible to reconstruct some states accurately in CitectSCADA 2015, but once all your servers are migrated, you should see these alarms correctly. This is particularly relevant for all alarms in Off-Un Acknowledged and Off-Acknowledged-Uncleared states.

UserLocation Field during upgrade
One of the new features in CitectSCADA 2015 is that it records the location from which a User made an alarm action (such as acknowledgement). Because this feature is not part of 7.20, if such an action takes place during the online upgrade, this will display location 0.0.0.0 once it has been migrated and displayed to 7.50.

Adding Summary Comments during upgrade
Any comment added to an alarm summary record from a client connected to the 7.20 peer will not be synchronised nor migrated to the 7.50 server.

Citect .INI parameters to be aware of during alarm upgrade
If you have these set in your 7.20 system, should make sure they are consistent with your 7.50 system.

- [Alarm]DisplayDisable
- [Alarm]AckHold
- [Alarm]SumStateFix
- [Alarm]Ack
- [Alarm.<ClusterName>.<ServerName>]ArchiveAfter
- [Alarm.<ClusterName>.<ServerName>]KeepOnlineFor
- [Alarm]SummaryTimeout
- [Alarm]StartTimeout
- [Alarm]UseConfigLimits
- [Alarm]SummaryLength
- [Lan]EarliestLegacyVersion

Ongoing Alarm Operations
The following Cicode functions will have limited to no effect during the online upgrade process:

<table>
<thead>
<tr>
<th>Alarm Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlarmSetDelay</td>
<td>Change alarm delay value. This function will not work during the upgrade when used with mode zero</td>
</tr>
<tr>
<td>AlarmDelete(mode=0)</td>
<td>Delete single summary entry</td>
</tr>
<tr>
<td>AlarmDelete(mode=1)</td>
<td>Delete one page of summary entries</td>
</tr>
<tr>
<td>AlarmDelete(mode=2)</td>
<td>Delete a category of summary entries</td>
</tr>
<tr>
<td>AlarmDelete(mode=3)</td>
<td>Delete a priority of summary entries</td>
</tr>
<tr>
<td>AlarmSumDelete</td>
<td>Delete summary entry by index</td>
</tr>
<tr>
<td>AlarmSumAppend</td>
<td>Add blank summary entry</td>
</tr>
<tr>
<td>AlarmSplit</td>
<td>Split alarm summary entry</td>
</tr>
<tr>
<td>AlarmSumSplit and AlarmSumSet</td>
<td>Add summary entry for adding alarm comment</td>
</tr>
<tr>
<td>AlmSummaryDelete</td>
<td>Delete summary entry/entries by summary browse session</td>
</tr>
<tr>
<td>AlmSummaryDeleteAll</td>
<td></td>
</tr>
<tr>
<td>AlmSummarySetFieldValue</td>
<td>Modify summary entry field value by summary browse session</td>
</tr>
<tr>
<td>AlmSummaryCommit</td>
<td></td>
</tr>
<tr>
<td>AlarmComment</td>
<td>Adding a comment to a summary record</td>
</tr>
</tbody>
</table>